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ABSTRACT

Nowadays, cars are increasingly being used for travelling. Drivers or passengers are
facing greater risks of accidents, especially if a driver has no driving license. Thus, obtaining a
driving license is essential for a driver as it helps reducing accidents on the roads. To obtain a
driving license one must possesses the knowledge of driving and traffic rules. This Android
application was developed to support and facilitate drivers to gain such the knowledge. It can
easily be used and installed on a smart phone. The knowledge text about driving is presented in
various types: pure texts, cartoon animations, and sound so the texts can easily be understood.
The contents in this application cover all the traffic signs, safety driving, including driver’s
qualifications and preparation prior to an actual driving license test. It also contains a self test for
users after using the application.  In the Driver’s License Handbook, the quizzes are divided
according to the contents. Moreover, there is also an animation game part which uses Animation
Gif’s principles. This part can help the users understand and revise the driving license knowledge.
The users can enjoy learning traffic signs. The last function is a searching part for the
transportation department or the location to apply for a driving license test. In this section, a user
can search for each transportation department in the country or the one nearby the user’s location.

In addition, a user can quickly search for the meanings of the traffic signs.
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2) dmﬁﬂm (Document Element)
Tudaufiaeei36n91 Document Element %38 Root Element CRNAYRERNEED
Element oy Tutonas XML14 luionans XML 11 Element zuansdnyas Tnsaas
ﬂummnmsuazuﬁmd:ruﬂ'szﬂawad;ﬁﬂmmﬂﬁﬁagmﬂu 110 3107 2.6 Wusaedreveans

2
14¥oyalu Book Element @41/52no U@ TITLE, AUTHOR, PRICE

<7um| version "1.0°7>
Prolog — XML declaration
L_| <I-- File Name : test.xml -->

[T <InveNTORY=>
! <BOOK>
‘ <TITLE>Harry potter<,/TITLE>
l <AUTHOR>).K</AUTHOR >

| <PRICE>$5.49</PRICE>
Document
elefent :t(BOOIt >

p i . — Element neste

element) ;BOOlb :ithln document
| <TITLE>The trn of screw</TITLE> ement
<AUTHOR>Herry James</AUTHOR>
<PRICE>$3.35</PRICE>
</BOOK>
| /INVENTORY>

Comment

31N 2.6 Tassad1aveaonans XML

2.6.2 m3tvaumganelulna XML Layout
o 1 ¥ @ 145 0 ' Y =2 L o
A 1A A 1A UDIA 2061971581909 Object View 11 Layout XML Tagazudna

Tiudams@eumdanmeluIid XML Layout d331/ 2.7

1. <?xmlversion="1.0" encoding="utf-8"?>

2. <RelativeLayout xmins:android="http://schemas.android.com/apk/res/android"
3. android:layout_width="fil_parent"

4. android:layout_height="fil_parent">

5y

6. <TextView

Z android:id="@+id/label"

8. android:layout_width="wrap_content"
9. android:layout_height="wrap_content"
10. android:layout_centerHorizontal="true"
11. android:layout_centerVertical="true"
12. android:text="" />

13.

14. </Relativelayout>

51U 2.7 msifisumidanielu1nd XML Layout
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Cadatloalaclod Sl ~ e P

|
{7 P e peEe— T e |
) ALT

ALY

-=i 3 = o @ 1
3"]."“ 2.8 ‘Iff“L!'mE}LLﬁﬂQﬂﬁﬂuﬂglﬂmﬂiﬂ@ﬂﬂ’)ﬂﬂﬁ

1391304 Object View 11 Layout XML

2.7 MWAAOU W GIF (GIF Animation) UHHOUAIOHE
msthamadeulfifuwagalddu - GIF  vuaaswunenndnduvedls
Undudnuneuasosdas llaunsamunmanowlna g faszda Mg 188am szuaas
Wisanmornmlsuusahiiu udtisondaitanudesnishammariu gy nue nas
Fu Tadoaimsldmdunuind gy ldidunwadonlnq14 [s]
Yo o o

@ 1 A o & gy d &
\’ﬂ'JE]EJ"Nﬂ'I'iLLﬁﬂQﬂ"IWﬂ"I‘W!,ﬂﬂﬂull“ﬂ'l GIF ﬂ"lﬁi'ﬂcl,‘]f Lﬂuﬂﬁ'lﬁ“']‘ﬂuﬁ NHIANTIHININN

A4 g Aad ; iyt :
nou uaaanlyod GifMovieView 104 Sergey Bakhtiarov
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X v =i ¥ ga
D A lFou Wahaluseavunudrad e g amsxmt #1310 2.9 mndufidaluld

3 Y = o
attrs.xml YULWAINUWAL 11

#0619 TUsun 30 T atts.xml iansdagalii 2.9

<?xml version="1.0" encoding="ut{-8"?>
<resources>
<declare-styleable name="GifMoviewView">
<attr name="gif" format="reference" />
<attr name="paused" format="boolean" />
</declare-styleable>
<declare-styleable name="CustomTheme">
<attr name="gifMoviewViewStyle" format="reference" />
</declare-styleable>

</resources>

(% 1

31 2.9 A0d19 T1)5uns1 14 attrs.xml 1A Resources 04 GifMovieView

2) i Idnm 6iF 1113 ulrawmes drawable

3) hilvdeaa GitMovieView 11 11uT1si0a ududaen Wd GitMovieView java tilo
Aanon Ind ldne 13 luTawmes Tsion
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= L4 o = 4 o )

(Ma 114 Layout w3 oe319 19 main.xml #3319 2.10 119213 Widget S50 GIF 18
@ =] 1 3 4 =
TUNAATUNNVBY GifMovieView 1 XML MaziududeFounmn a1 ldauase

Y Yk 9/ v a w & v
ﬁ@Q!.lﬂ‘h’@LLWﬂLﬂ%iWﬁiﬂﬂﬁJLLﬂWWﬁmaﬁuuu‘;] a3y

#20819 T1)sunsu Ind main.xml werasAsgii 2.10

<RelativeLayout

xmlns:android="http://schemas.android.com/apk/res/android"

xmlns:tools="http://schemas.android.com/tools"

android:layout_width="match parent"

android:layout_height="match parent" >

<app.akexorcist.gif. GitMovieView

android:id="(@+id/gifMovieView"

E‘Llﬁ 2.10 1298191150053 ul‘ﬂﬁ’main.xml LAY Layout U4 GifMovieView
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a o & Y o d . . 4
TdNwimduieuans Layout v3afmuaswaz@eauos GitMovieView 1114

AndroidManifest.xml ﬁﬂgﬂﬁ 2.11

A20819 115N 53 1WE Main java uarmadagiii 2.1

<?xml version="1.0" encoding="utf-§"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="app.akexorcist.gif"
android:versionCode="1" android:versionName="1.0" >
<uses-sdk
android:minSdkVersion="8"
android:targetSdkVersion="17" />
<application
android:allowBackup="true"
android:icon="@drawable/ic_launcher"
android:label="@string/app name"
android:theme="@style/AppTheme" >
<activity
android:name="app.akexorcist.gif. Main"
android:label="@string/app_name" >
<intent-filter>
<action android:name="android.intent.action. MAIN" />
<category android:name="android.intent.category. LAUNCHER" />
</intent-filter>
</activity>
</application>

</manifest>

31U 2.11 Meg1a T sunsu T§ AndroidManifest xml

LAY Layout U89 GifMovieView
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o o kY ' . % y
6) dmiumsisenlyaulunfissnlsemasenldnara GifMovieView iay

o 1 =1 o W o G4 4 @ A
Mruannaisenldnimaaldmnua ld GIF Adeems 1§y

a10619 1)sunsu' W6 Main java larasdagili 2.12

package app.akexorcist.gif}
import android.os.Bundle;
import android.app.Activity;
public class Main extends Activity {
protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.main);
GifMovieView gmv = (GifMovieView) findViewById(R.id.gifMovieView);
gmv.setMovieResource(R.drawable.apple);

}

ﬂ.{ o ' a - 49 £ 4 e
JUN 212 dred19Tdsunsu TWa Main java naasnaiaans GitMovieView

7). dmFvvuaveanni1d sz lignuesauvuinaed Widget 8n@10819 Widget
YUIA 100dp UANWIHEY 50px 92 Tvenadin 100dp uanImIziaAsagluvLIR S0px

a 1 3’; A 1 1 a ' 1 Qs
miou@umIY nsmna M Inand Widget nazgndoasn 1Ay Widget unu
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3.2 UHUMNUBATNIA (Activity Diagram) Ve U@ WWAIATU

14 e o A wa ~ o
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3) MSAUINY (Game For Driver)
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!
|

[ wWhgnimanveuny | waAvuyvouns J
S

A

BoAMILEAULNY

L @oNAINoL }*

|

) IR ) ° : ar A
LR 16N 1L Z @l O 1 —

AR D

Tiagu
A7 01)

TIUIUAD

gllﬁ 3.4 Activity Diagram MUV (Game For Driver)




22

¥
g

4) MIRUMNNAINTVVUAINIUN

User Application

>l
«

y

A v
[ BonlszinnmIaum

LAAINNA

~ Y w
nlnanugm

2N

[ AFDNADATUVUAINIIUN )

( ) &y
> LUTAINNANAUYN
i J

[ BonuaAUduUNI }4

'r{ uaraudun1g J

.‘

vy
@

311 3.5 Activity Diagram M5AUMNAINTUYUTIMILA



5) mMIAumIthees195

User

Application

!

[ W gynsum

)
)

{ HEAAANYNTAUN ]

h 4

A
[ n5N¥DT1095195 ]

g Tainy
AU

thevs1ag

uaasgiihoesies

LAY ALIDe

311 3.6 Activity Diagram msdumiheasios




EY '
6) maasmmsiaenlueygnduivwlfiu

24

User

Application

!

) &
FINEMInoU

Tueygnaludvd J

\ 4
e

Aailgnu J

A

L nsendoya ]

29NN

U

Toi ey

310 3.7 Activity Diagram m3asmmsiden lueyanaduiuulgiu



25

3.3 t"nuvimh:muﬁ'ué”l% (User Interface)
1) yman
=)

a [ [ J LV
nihvewyndan udailumwydes 5wy 18un wyglowIsNael ynuavlALay

4 1 & ]
MSIETINAY IYUULNATOL WLauIny LazmyRuminansuvuds dagili 3.8

@ Driver Handbook

a Y o
31N 3.8 vihvewynan



T =
2) MYANOINSENTOU

1) 1

26

A ~ (-1 1 g ) =
ﬁuwmwgummauﬁau LL‘INL‘]J‘I-JL&JEEJ’EJEJ 21y nlﬂl!ﬂ mwmwa‘aumqyg Haziuy

'
[ =

wIsuaoUUR Asgln 3.9

Q

@ Driver Handbook

310 3.9 mihwewyglowsonden



27

= =
3) NN TOUNG )
3 ) = [ ' Y 1 o A a
wivemyTouaeuNgB] uiautlumytes 5wy laun wydilew wynanias
Y v a ¢ A w s o 9 @
Tu50 wydaydnualnioameeses wynssiyga wasmydeuunhlums 1950 dagl

73.10

@ Driver Handbook

31 3.10 oy ouaeungud



28

4) sipesenaeulfin
kY = a s v 1 9 0 | A oA 1
wihvemysssneul UR wiuthuuydes 7wy Taun mwyvii 1 wymii 2 wym

1 3 YA 4wy 5 Wi 6 uaziuy i 7 Aegaii 3.11




3.12

5) myuaaamaeulfin
nihvemyuaasmaeul§ia wuaasginmueiindumaouljiia

@ Driver Handbook

G

n']n o
/ \
msuusnmurmua NosHA)
1UnM0s)

b ; wanfoa

_ éauTuoqmmuusnua.ugt.ls-’nsn
%ﬂunuI msawnuwuuauhm nmusn
-f

31 3.12 wiheowyuaashaeulfii

29



30

6) 1y

nihvemy o wugannumuevesmilouineltosums A dagii 3.13

*—ih E © = "Iﬂmn‘ D 19:26

@ Driver Handbook

31 *MsIsTS” H =0h ¢
“mslamueniiiud puiauIn

© HSoAUM) B HolAtioudns



31

7) WYNYNAMMITUSE
o a @ 1. g ' ¥y ¥ o
nivelyngnANMITTUTe ulutlumydes 2wy Taun mydeinua uazwy

Foms 195 ldouu dsgih 3.14

~ & FH v

@ Driver Handbook

© JomHuo | 33mslasnldnuu @

i o) e g IR

USIDOUUOUNIEY - IH&D)
Huefumuseasndundtgasu - dnu
HSodwolaucU: BuUsHeUthesniva

J
plé

Call e 3 Adrs

n-(

© < @

31N 314 mhvewyngaAnmmMsTuse



32

v d
8) IIYTYANYANNTOIHINLIIINT

9 v w ¢ Al = 1 TR
Wu—]ﬂaLNHﬁﬂJﬂﬂ‘Hmlﬂi@ﬂﬁlﬂfﬁ]ﬁ’ﬁ]ﬁ Llﬂﬂﬂulu‘lﬁlﬂﬂﬂz Wy ]rlﬂLLﬂ ll.ll‘\}ﬂ'lﬂfl]ﬁ'mi

LAZIATOINIIIUUNI uazmydyaans1os Aagili 3.15

@ Driver Handbook

é@ﬁm

thersrs na: g o @
; Fone 10U3SIAS
INSIHLIBUUN) 7 l'lJGJy =

themsmsussinnithauiAu

IASOIHUNENSIASULIWUNT
P e et B ims L R € § iy

:
o g A

= Y ¢
g‘l.l‘ﬂ 3.15 TT‘I—!']%@L?JH‘} UANYUIAIDINWIYDTIDT

a



33

9) MYNITNYURUA
=

nivemyglewsoueou uuilumyden 2 my TAUA iy w.3.u. 500U WA, 2522

EURCT

LAY W.T.U. MIVUAINNUN W.A. 2522 A931I9 3.16

t

@ Driver Handbook

& guosuluoyanndusudaouypna
gonsvtiosloglitiosnd 18 U

& unuosu?uoqmmvusmnsmuauﬁ
40UUARATINSINDAIILANS:UONGU
loifu 110 33 Goslongluthng1 15 U

@ wuosuluouoydusneudehsisaus
Goidonglutiosns) 22 U

& duosuluoyanodusninsenusud
asiscustioaionglutiosnsn 20 U

& Tuoyopaviadonsioios 17

& Tuoyapndusnatadouynnaiion 5 U

& 9/ v W ¢ A
31N 3.16 ey dyanvalns o193



34

10) wydenuziinlumslise
Y Y ° v 1 a 1 Y o 1 a
nivamyveuuzih lumslosa wiathuuydes 2 wy 1dun wydusoedtalasant

uazmymsthyesnuise degin 3.17

@ Driver Handbook

& \osnide AastnsnavaRNIIM) a:
Walwanidu

8 doyonauluifouvunwHindasnadins
AluAdsUsINgueuEdUsn

& Tumsdusnifassssum msHgasnA
qndiosnasiHEaUIUSNIloD:a0ANLISI
fiou IAYIHSUUAAND

& msiuwoinae toonasogluanuou:
dadiorufiriuwanaslins=au ua:
awnsnhyulndondo

1 3.17 miheydenuzai lums 4o



35

e =) s
11) FHUAMANUANTIA TN

v ua =) o [~ 1 1 3 1 sy y:iz:s
“ﬂu1wmmmﬁmummzﬂmmamm LLHQLﬂNLMHUBU 4 Wy ulﬂuﬂ L?Jklﬂﬂlﬁl]‘ljﬁﬂﬂil

1l : ' ¥
anslumsfesvereuludvd  wyenmslunmstuvesenludud  myvuaeulumsaoy

o

Tudua uazmymsdooig ludud sz 3.18

U

@ Driver Handbook

7 g
NaLIAWADANS ums
_ SvoduTuIyE




36

12) SIYUIUNATOY
[~ 1 r o A
wihwemyuuunadey uduilumydes 5wy ldus wyuuumaaousiion wy
@ W L4 y a s °
HUUNAAPUARANYAINAZIATOINNIBITINT WYLUUNAAEUAAAMMITUTO mwydouuzii

Tumsldse uasyuuunagensumniaes fagui 3.19

@ Driver Handbook

S (B
®

X% AU

dojanual
1Az1IASOIHIUIEIRSIAS

NONANINISIUSH

Jonu=tnfunistasn

U4 3.19 wilhmowyuuunagey



37

13) (HyUARNIMONIDAATLNVBUVLNATOY
nivewyuaaImnuuazduionvewunagoy zuaaIfInNLATA IR 0N 4

dufion1dglsaenaey Aagilf 3.20

@ Driver Handbook

*]
muwitheas1su
HueANuosls

S nuiGusnnuiGealumidng

¥ nuIdusnniGealunum

¥ TWiausonmaidesludnuH

¥ THooum

310 3.20 wihvewyuanImIn A A IR AYBUILUN AT DL



38

14) 1NN (Game For Driver)
1 2 T | 1 9 1 2 '
WH90IYAWINY (Game For Driver) sijuiluimydos 3 1wy laun wysuaumny
dmFudignisiawny wyIsEu dmiuetU1eITMsauny uazynaunTIMan dmsy

navu ldunyndanveenndngu dagili 3.21

<’ Game For Driver

31 3.21 mivemy@UnY (Game For Driver)



15) WYHEAIRINInY
kY = =) LY o v A o A 9 9/
THIIBDLNYLTAAIRNININY nJummmum‘w!,mmmmmm:mamﬂﬂ 2 ﬂﬂlﬂﬂﬂiﬂmﬁh

@onaou Asgili 3.22

G‘, Game For Driver

LR L AN ADW .




16) (AU

Wiy

(9
s

40

'

MNNINVUE

¥ P

AUNIN

=

z ' ' v I A ¥ 1y a
ANTUVUDN ELUQﬂ’lﬁﬂUWTLﬂu 2 NN ]lﬂ!,lﬂ ﬂﬂ‘ﬁﬂﬂﬂﬂﬂﬂ

VK1 uazAuAI8 Google Map fa317 3.23

Google Map

¥
4

511 3.23 mhvowyduminansuauds



41

¥ 1 a s Y YVas
17) !.N‘l;g!.!ﬁﬂQﬂ'liﬂ‘u‘l‘i'lﬂiu‘lmﬁQIﬂHWﬂﬂmﬂﬂﬂiJQm

1
=2 o

nihvewyuanansduninsuvuds lagiinan lnddugm Feszuaaaiumialegiiu

q

h.

¥R 1% (MyailngUdnde) uazuaasdumiansuvudenndnud 14 (yadndues) dsgUa

U q U

3.24

@ Driver Handbook

L
Y

f %
. Prachathipat |  Lam Luk
R Ka District
Sikani/'. '} L ‘
4 SaiMai t f£ — - Khlong Sip Song
-/’ “7 -
ang Khen | .
_ 7 Nong Chok (401
chak : , : ‘W
/ ~ MinBuri
A

——
e

Prawet La rabaqg
. : \
a'} Dok e A v)
4 /BangNae o sl \
RN, R
- / S
™~ g . .
“._/ Bang Phii District N
Pak Nam ™ — , \
> Bang Bo District 3
|3115 g S
(3] ‘ + P

Google
by Thailand

‘::r 9 9/ 1 = ~ kY
gﬂ‘n 3.24 'H'H"Iil@m‘kﬂlﬁﬂﬂﬂﬁﬂu‘ﬂ'lﬂill"lluﬁﬁiﬂﬂw anlna U



42

18) INYUAAIMIAUHINAININYUAIIAY Google Map

9 Y, AL , & v a oA
ﬁu'ﬁ]@m%&uﬁﬂﬁﬂﬁﬂuﬁ'mﬁﬂﬂ'ill‘lluﬁ»ﬂﬂﬂ Google Map G]J'»‘llﬁ)cl“lﬂ'I‘L‘I'CT'HJ'liﬂ‘l/\lll‘l"l“l‘f'f'_]

a

]
=

| A 9 Y A 3y Y o
ATHUVHAINNUANADINITAUN LLa5ﬁ1n1§ﬂ£ﬁﬂﬂl!ﬁﬂﬂﬁuﬂ’]qqﬂ ﬂdﬁﬂ‘ﬂ 3.25

@

~ & M 3 5
o

L O nsuaudvd X

aiton

‘—ia

| 1000 e | _@_ f
2009, | |

Qs é’
AUANUDURILYEIN...
4-! g:&f.’:’”b_i‘,k 28 uwi

¥
Q

51 3.25 nihseudaimsdumnAIsuAUAL 1Y Google Map



43

19) siymsaumtheasos

v Y = 3 a ol Ay v Y
ﬂumﬂﬂﬁﬂu?ﬂﬂmﬂi’]‘ﬂi WQPﬁ‘UHHﬁ’INW'EﬂWMWWBﬂWU%Wi‘]’lﬁ@ﬁﬂ’liﬂuﬂ1]1@!

@ Driver Handbook

| Search

nTAve

AW MITIMIN
Tavlinghe diuse
MBI RINDANAITURY
\usafaaughase
ANNTEIIATEN

nvlasen

AMUMIIE MVTWININ
Tl ndusa
MTRINDIUAITURY
Wiusadanugioaiu
AT

molasiafiuauidendie
AWML MIDIIMIN

Tav¥afiuaulumegie
tusanrnasnwaauals

31 3.26 nihveuanamsaunitheasns




20) sy IURyMY

44

w =1 ] v o W @ 1
nivemyasywy Hunssamyimua Tassadhidemyndnuaziydoy

T ldnudenuy ldmudeants dsgiii 3.27

RS YLNY

u

°® AllalmAuURDY
* IALURDUNO WS
Afleny

ARARNINSTUSA

AoyaneallnIosnigusas

WS YUYaa
Fauuziin lumsldsn
L AGEHHERIBRI

ViniA 1

51 3.27 wihsemyesinuy

U




45

:/ \ =) o L 4’ aa
21) !NHﬂ1iﬂQﬂ1ﬂ1‘5!?]81«!ﬂ157|111]91§€g1ﬂ‘l]1]‘l|‘l]141]§]111—!

9 a’; 1 A o v A aa 9/ Y 1 an
wumamu‘jmmﬂmmumsmﬂmumﬂ’mmuwuﬂgwu Fﬁ“ﬁ\‘l'luﬁ'lll'liﬂﬁﬂﬁﬂaﬂu

au U

o

1, A ) P4 ~
uagﬁaﬂ'lﬂ'ﬁlﬂﬂuulﬂﬂ’lﬂllll‘%u ﬂ\?ﬁﬂ"ﬂ 3.28

UG

@ Driver Handbook

AcuaLsneuMsiffiou
- |
iwotloglududiuolncu

dr 3 g’ ! P ° v A an
3% 3.28 miamyamMsfoums lueyaeduIul Y



46
d' o a o
22) ngInuULINNalAY Y

9 = cu = Y Y 3 dl [ = L vq =
HUNIBDLUYLNUINVUDWNALAYU 1WM®HﬁLﬂBUﬂULL’OWWﬁLﬂ‘Hu 1’i'lﬂfﬂ1‘])’x1']‘l—lﬂ

dowerupuuz visAruanNIndInuRMTuAInG1 18 Taonaiju Send feedback Aag1lh 3.29

@ Driver Handbook

DRIVER HANDBOOK

lwwalnaunAuaInsyUgouUJUY




UNN 4

Han1sANUUIIU

a o . ] .
LOWWRIAFY Driver Handbook 1Agnaitstiuvinlusunsu Eclipse Taoldn1wt 91m

v 1 £
ooP msldnuuenndnduil fldez ldsuanuinnglenswsouaeuluduy soumsng

U

= 1 & =] y Y A A g g1 3/ a %
nAnNsemMaee Feztlumslidldadndendloninnuiaie 18neTuwenndma

@

! 3 ) o a 6”1 = Y n:%.’ ad o g
Tudawosmsldan flédesrhnmsanauenndmduil Tassaail

4.1 MSAAAWBNNAATY Driver Handbook

[

¥ ¥ k4
N1TAANULDNNALAYY Driver Handbook ﬁmumeu a1

4.1.1 duATauNSNENNS

9 ) ¢ | w Ao @ W Yy
1) Auaianns nsnensnodludoaly laun

aunin Tusz1) 1AM 1euATOUA (Android Smartphone)
o u USB iFoude auninTviu fu nouiumes
L] Lﬂéﬂ&ﬂﬂﬂﬁﬂlﬁﬂg (Computer Notebook)

2) Mumendig

® LOWWAIATU Driver Handbook.apk

317 4.1 lonounennanFu Driver Handbook.apk



48

412 mavhuewwamiuiidean Eclipse inilulvla .apk
Tumsihuewnamdu 1/ 1FnueTawuaundn Inuvesuounsosdazdoariinis
Export Package ﬁ'ﬂﬂmﬂﬂlaaﬁﬁaguu Eclipse 1913l TWldwwana .apk sz
1 apk TAassunau$n Iudiosussaasn g apk aslu D Card vinudiduidia
adnruieuaseumnisAnsauaz 1Fa Idlusiud Susoumniennamduidou

= o

3
Eclipse Mudlu'lWd apk dail

9 [
1) auusnlidla Project 1 1d%@U UL TY50n5W Eclipse

Run
L0 SRR B SR e e Quick hecens L o [T) 9 vebg @ DoMs @ HeehyView T /1
1 leyout mainami [T 4= BE Outline 12 -8

. L v DNeuone v B v| & ApgTheme «| @ Muinciiy ~| @ <] < [ Relativelyeut
4._'ng —"—-—!"—;— ‘: s -

[eax:-v;: [ ED o e
et | Medium
|small

AAQIQQ

| repeni ¥ AInwe

«Na properties

e . Scvem b Jedmesis (0 Comee T gtel Wisns QEnerlog 8l T Lot iy e BhXa¥ =0

! o = ar dl = " o o 5 {
31 4.2 marhuewndnguideuun Eclipse ¥uilu 1 apk duneui 1



49

2) (53 Export Aulnd APK adnund Project ->Android Tools -> Export

Singed Application Packages..

Ll Jova - Oriver Handbock =g
File [dt Refacor Seure Mrvigsie Sesch Project ©mKeool Run Windew Help
Fiw oy A A e R " Quick Access 3 | [0 2 Debug @ 0OMS @ Hienwrchy View [ €/C-
|8 Package| GOl ~ - S0 layeutmainaml 1 =1 2 Ouline 17 -0
v Open in New Window Palette —— 4 (1] Relativelayout @
SEDR  Open Type Hiermchy Mok .|E'|D"—-°-'|B'\*M‘"m'|ﬁw—\ EDEM &
= OmageView) - bt_homy
(] e AWy FL[ © [ au - gm"'"..i..:j‘n.:; GO |
) aec  VIEW E = =} Ihome_2 fln 1-imghome B
- : cc::wum I_|W‘ oE- @ BAQIa® Bl g bomma;3 Omagetiont img.home. H
‘mia e v |d s 7 2 imghtnbom.t i) - mgems
ey i) ate. = I 31 imghtn_home_S limageVion) - img_heme
Oy { N Delete O T
“;‘1‘“ Build A
G  Sewse Aneshifies »
WY At ShitT s It 2 “
i on
i By S = | )}
& Mefresh 75 | Mew e Project.. I3 Properties LIS
Close Project i MewRessurce Fie... A g "B
Clase Unvelsted Prejects e i B y ‘
% Sy Appicalon Packope. Background | Qderwablerbg home (=) |
e Expert Unsigned Applcation Prckage.. Pgtan  Simaiscy L
Run As » i Content Descrl.. ElR
I  Relativeloyout (1
4 Rename Applcaion Package | oty ]
Prafile Ac P 0 Suppert Libeny Ignore Grvty =
Vaidate P Proct roparties evh;’h ]
— "1 @ Ntk Crck o Comemon Eros g g
Coegpata Wi B Ay Background [ @drawablebg home (=]
Restore from Local History.. Widget GiMavienView) does net amist. Pedding
Andreid Took b Rddbative Suppert.. gk dkmaiachiy g
T mrepeties PPNy s v Py SRR *
Deiver Resource Configueations v | 2molam @

3) e Project Driver Handbook

@ Export Android Application LB B |
Project Checks
Performs a set of checks to make sure the application can be exported.
Select the project to export:

Project s Hanibook_ | 12705 Y

| No errors found. Click Next.

@ [ e ) e

1 o = v oA A 3 o o o 3’4 {
5UM 4.4 marThuewwamunWeuuu Eclipse iuilu1a apk vuneui 3



50

) L < o @ T 1 P
4) Tusouililumsiimua Keystore M1nde 1l 1nsonlny TaoidenInamoii

f0ams uazla¥o Keystore AadI0e1auazMmuasian i1y Keystore A28

@ Export Android Application 8 = |
Keystore selection @
() Use existing keystore
@ Create new keystore
Location:  D:\[Degree 4]\project\APK\DriverHandbook\DriveHandbook.keystor

P , |

| Confirm: P ——

@ <Back || _Net> |  Finish

o == e

: ° a o o o (4 Y ]
311 4.5 M wennAnTuNWouUY Eclipse inilulWa apk vuaoui 4

o & o = ' a w
5) AYUA Key Creation %QLﬁJHi'IEJﬂ&BEJﬂW'N"’] VDILDWWALAYU

@ Export Android Application [ pBIT I |
Key Creation @
Alias: DriverHandbook
Confirm: R aesnsaasat o) LAY

Validity (years): 25

First and Last Name: Thitapa

Organizational Unit:
Organization:

City or Locality:
State or Province:

Country Code (XX):

©) ([ <peck J[Het> ]| ginin | [ cancd ]

! A A o 2 =
314 4.6 marvTuenmdmduRFoun Eclipse Huilu'lna apk dunoui s



51

¢ ) S s
6) v21ls1ngri1veueas Path v 11 .apk Ndoen1s v1nunliden Finish

@ Export Android Application

CHEEN

Destination and key/certificate checks
/1, Destination file already exists.

e

Certificate expires in 25 years.
* WARNING: destination file already exists

Destination APK file: D:\[Degree 4J\project\APK\DriverHandbook\DriverHandb

Mext > |

Finish

ey

310 4.7 marhuenwanFunWenUY Ec

lipse viudlu .apk VUNDUN 6

a g‘/ | o ) é
7). waanntiuee I3 IWg apk fieziir 1y 1493 eeeiivies Indidan

eov[ i ¥ Computer-» StudyDucs(D) » [Degreed]'s project »-APK » DriverHandbook
Al - Sl L (S g S AR il 2

=T

- | ‘,J | search Drivert... P

Organize v Include in library « Share with »

~r Favorites Name
| DriverHandbook.apk
., DriverHandbook keystore
| Recent Places
79 Libraries
[¥ Documents
&' Music
(i Pictures
B videos

% Homegroup

% Computer
&, Local Disk (C)
s Study Docs (D7)
€% DVD RW Drive (E) M
== Removable Disk (F)

@ Network

J 2 items

New folder
Date modified Type Size
19/3/2014 242 P APK File

19/3/201412:03 PM  KEYSTORE File

107,058 KB
3KB

ik .

{ ° a @ { o o < ?z i
3UM 4.8 msihwennAnunouny Eclipse intlu 1Wa apk dunaui 7



52

4.1.3 m3nanalvd .apk asvumninlviy

({93 Export 1Wd910 Eclipse oomilu 1Wd .apk 1dFsvosuds ndu'luss pc

Desktop 1M3¥ouaeau1inIny v USB w30350u mevzid11isan13iu SO Card 3
3 F
VUADUALI

1) MmsdEeudoauin IWuHIL USB

e @ =®
ek-ljvll‘ » Computer »

|

> &% BD-ROM Drive (F) I

p— — = i - | 4y ‘ I Sg:ihgoﬂa.}tu Fel ]
Organize v Properties System properties Uninstall or change a program Map network drive Qpen Control Panel &~ 0 ‘
4.7 Favorites 4 Hard Disk Orives (2)
B Desktop Lecal Disk (C) Local Disk ()
18 Downloads B ] )
| Recent Places 778 GB free of 228 GB S0 130 GB free of 102 GB
% iCloud Photos 4 Devices with Removable Storage (3)
4 & BD-ROM Drive (F:) INSIDIOUS_2
4 4 Libraries $ DVD RW Drive (E) & & 0bytes free of 305 GB
o it Apps UDF
5 [¥) Documents Removable Disk @) ¥
» a Music 3,41 Ghfree of 3.75 6B
b el Pictures
» B Videos 4 Other (1)
@, iCloud Photos
4% Computer System Folder
» &, Local Disk (C) J
-
¥ ca LA DR Portable Devices (1)

T
(@) i-mobilei-styled
 ump Removable Disk (k) “ Portable Media Player
o, i-mobile i-style8
> €l Network

i-mobile i-style 8
Portable Media Player

' v v y
51/ 4.9 M3AAAa IS apk aspuanTrlu Tuaoud 1



2 4 2

Y )
2) Julasdl D card WvhmsadeInawmedazaate lunidadedn “Install”

R T .
G“Q' e * Computer b i-mobilei-styled » Aifiudesninedud » vl‘flL{:ar&' Aidudegelns.. 2|
e = = —— = = —= - = = T
Organize v s~ 0O e
e "
< Favorites ] .android_secure avg E
B Desktop File folder File folder
& Downloads
‘¥ Recent Places «dataviz skynet
# iCloud Photos File folder File folder
I
= Alarms Android
j 9 Libruries J File folder } File folder
M & Apps
g [3] Documents DCM documents 5
i o' Music ’ File folder File folder
I (Il Pictures
B videos Download foursquare
’ . Filefolder Filefolder
™ Computer
1 POt 5 Gameloft Install
Local Disk (C:) Tile folder File folder
s Local Disk (D) i
4% BD-ROM Drive (F) I LOST.DIR media
= Removable Disk () l; File folder } File folder
. i-mobile i-style8
Movies Music
& N File folder File folder
I Notifications } Pictures
File folder File folder =
23 items
L

H 9 Vv H
317 4.10 msAaaa Tid apk asuueininTvu Funeud 2

3) vhimsAnaen W apk aaluInamos “Install” 499 SD Card

e@.j |, » Computer » i-mobilei-style8 » fiAudoyninednd » Install

Organize v
N vl o . :ml:d:?.:: kage Fil
uestacks Androl ackageFile
{ B Desktop v 104 148
# Downloads

1| Recent Places
% iCloud Photos

4 Libraries
& Apps
B Documents
J‘ Music
[ Pictures
H videos

o e e -

1% Computer
£, Local Disk (C))
s Local Disk (D:)
&% BD-ROM Drive (F:) I
== Removable Disk (&)
{. i-mobile i-style8

€ Network

’ 1 item

o) ¥ ¥ r
U7 4.11 M3Aeaa IWa apk asuuauinTru Yunoud 3

53



54

' 4
4) TlfaninTwuldidle Browse 9 Inlalu SD card Tuiitiidla “dasams Ind>

s 4.12 mananIng apk a3UMAIIN Iy ¥ SunouT 4

5) 19113t SD Card vosaa I N Iuuazidh 17 IWames Andedn “Install”

a ?ﬂlﬁu'ﬂau!
L uoLuinens

@ Download

7] foursquare

7] Gameloft

£ Install

FLosT.DIR

E] media
e, Q

sin 413 msane Il apk aquuausn Ty 4 SuAoud 5



! i 8
6) ot 1y luTWamesazne W4 .apk 71'18¥1m15 Copy as13nounihil

a Eﬁuﬁm’fau !Install !

=, . DriverHandbook.apk
A 104,55 MB

A L2 g
a a ¥ % ¢ g =
31N 4.14 M3finas la .apk aauuain vy Yuneud 6

9w qy = 3 o a g’.ﬂ = )
7) 11’1ﬂ‘ULﬂﬁﬂﬂﬂLLﬂ'ﬂﬂ1ﬂ']5ﬂﬂﬁ\3LmWWmﬂ‘lfuﬂ%ll'u Smart Phone

«~ @& 2

@ Driver Handbook

UnLAnN

H ¥ 9 !
1 4.15 ms@aas 1a .apk asuuaminTnly Tuaoui 7

55



g a

o Aa 9/ Y Y a ~ =
8) HAININNAAAIL ﬂﬂﬁﬂﬂllﬂ?iﬁﬂﬂﬂ‘ﬂ "Qla

® 2

M Driver Handbook

Uil 4.16 miaanalWg apk aqUuausN vy - Vunoud 8

2 2 - Y

Y a a { o
9) ﬂgl’lﬂLLﬂWWﬁm‘HUﬁﬂﬂﬁQlﬁ'im‘ifJ‘lJ';T?JEJ

31U 4.17 msaana W apk asunauin iy Suaoui o

56



)

4.2 M3l NUeNNAAYY Driver Handbook

"
=

ﬂﬁsl“b’ﬂ'mLL?JWW@LWHHUN‘HWIEJL&JH Fﬂ”]fﬁnﬂiﬂﬂﬁﬂlﬂ@ﬂm una s‘lﬂ’]‘iulﬁrﬁ”lﬂthéﬂ'l‘i

¥ &
¥ uesduiaed

@ Driver Handbook

31 4.18 vih9eNANYOIWBNNGIAFY Driver Handbook

L7 T =
4.2.1 M3linugiemseNaey
o lg
Sunoumsldendiae

Ll U

D Gulaedldadniy “gilowsouaon” sdsnguiiuiy faglf 4.10

- @& 1

@ Dnver Handbook

a0aceeceoo | 0 ) 6]

i‘l]‘n 419 vihvoudauuyg Wi onaoy

U



¥ 9/ o a

2) flddeamsdn llgdeyaninerdestungud

@

o ilpadantju “wisendeungu]” valsngriiuuy dagilfi 4.20

@ 0

ﬁ Driver Handbook

= £ 1A &) a
31]7] 4.20 ﬁuﬁlmmmmgauammnmumqy;}

o fenaniy “wsondeullfun” wilsinguiluuy Asgun 4.21

a

58



59

@ ¢ A

! -g ' 90 = ar
3) Tudnveunseudounguziiiion Taun dilow dydnysinieanuny

o sy

93195 NYAANMMITUs Youuzihasldio uazwseswiyala

g g

o jenanifu “milow azilsngmiuuy Asgii 4.22 fldeunsandniug

Q

Yayanihae 11/ 18 Tavadntjugnasdaldviedoundyld

a Driver Handbook

d' 9 g o a
3UM 4.22 mineuanaiiomimiiny



60

o o

o lonantu “dydnvalinoimunenes” sz I ludamibneas les

§ 9 = 1 9/ [ 4
517 4.23 gldaursaidenndntugdoyaludiuves thouazinseanune

a 9 g ' A A a 1
vune Taofideyaiion wu thossresdsziandeu dendnify «the
9/ ' 1 s { &
viesiszan@on” szudaanihvemy ludiuae i degiil 424 a9
= d o v oW
sanunmauntheeses 1d uazdheesesdsznnihefay e
< & 2 &
v51v5Uszanthouuziil 1A504MUIEITINTUUNUNIL 1AT0INUIOYNAS

Vv ¥
VUNUOUU AT 0IMUIIATNUUINIUAUTD

@ o

ﬂ Driver Handbook

ANUOT IPSOIHLNEAS 138 - .I-

RCEpe )ﬂC\JEUlMSﬂS‘ @

ndarnpuun)

thirsrsusannthentiou

INSQIHUNERSTISULNNT
: 3
IASOIMLNEBNFASULLIUNLL

L S o=y

IPSOHUNOMLILDMAGUSH

a v &4
Eﬂﬂ 4.23 Wu’mﬂuﬁﬂﬂlﬂJHﬂjﬂlLﬂglﬂiﬂﬁﬁﬂﬂﬂuuWTQ

-~ @& O

@ Dniver Handbook

[ Search

nw AL

ATIMIND YT W
TAslvmethutidiusn
TRINDEUAITURE
WusnBasuthoain
Assiniete

A

ATHIMNY NHTWMI
TRl tvitiuse
WaInaaNAITUAL
usnfaruthoain
Awsediaseio

muTadiasluaudma

ATIMING VTR
ﬁ Tas¥rdluaytmothy

WiusnaIwaENAIs

51 4.24 niveuanstoyathessessznnidon



61

a 1 9 roa =
Wy dyanaees Ysznoudlewyden 4 wy ldun dayanalyl maduse

4

Wesdyans uazdygrademinausmehi dsgili 4.25 uag 317 4.26

U

-~ @ 13

@ Driver Handbook

thosms we Aoyoyicuisms @

RSN

U197

Zan

|
=p.
=
o]
u:
"
Te
=
e
2
)
e
r o

e

e
2
2

= o Y Y

= 9 7 o P
51 4.26 wihvouanstoyadaanadiominnud i

U



62

® endntu “ngnaninsduse” zﬂﬂﬂg‘}’iﬁ’]m fagUit 427 dudau
& & s d YA =
wanaition “fofmua” Sidesmsqiilonidu wiiuiu g1 #donn ou
ar g
Tudaumition faqulfi 428 Wudauuaaaiiont “F5n1s 1450 ldauu
gldasondnijugdeyanididellldlasadniugnasdaldnie

kY o 3
doundu'ld

P =

ﬁ Driver Handbook

e BER)

Jofmkua -SsmsbsnTnnuu

wlidunndns)
‘ 'sm.uréaxmﬁ HoqUnsai HSodou
mmﬂmmmmﬁm

1 @ snalloruorfiummoniaowlacans |
amm,am HSoURmnquUM)
& sofido Sodovdudsdomilildey |

!! Bustdsoililusmstnsa 3{‘
| @sniomSopuddoliiann du Adu

IAANCURANGHLEMHUO

© < @

3 ¥ D Y o
E']Jﬁ 4.27 ‘I‘Tu'mﬂllﬁﬂﬂqlﬂuﬁ"llﬂﬂ']wuﬂ

& n

ﬂ Dnver Handbook

oy

51 4.28 ihveuaasdoyaiimsldse ldauy

U



63

R.

L

y el -f cv wa 9 3 1
o endanijy “wsznmigaa” swusinguiiy fagii 4.29 dludiunaas

a U
3/

¥ ]
iWiont “w.s.u. saoud WA, 2522° ddeemsquiionidu seluiuligly

{ ' o { 3 ' A
@onulasy ludiuniiive Aegilin 4.30 Wuduuaauiiont “w.sa. ms

YUAINUA WA, 25227 f ldansaadntugdoyamiae 1 1d Tasndn

Yugnets lil-naula

e Driver Handbook

) AGAIANS:UONGY
Tiu 110 88 dosiorgltnnd 16 U
& duosuluoyoyndusnoudensisou:
dosdoghitionndr 22 U
& duosuluoyopodusiinsenusut
msiscudonioghitosnd 20 U
oo vow 1U

£ Tuoyonaiosonsiio N
8 luvoyopadusnviodouypnabor 65U B

© M5 sn H euwnKuNNBGONIIY
msuudinuun Bxdudioamdl mdooud
Mmduith Kowfnudy seHnenw
saufisnunosndudon sndusoly

& Md msuudilsin KHNBANUHIMS
vudndouinmuidunifncunssums

fmuo
& frh msvudlbusAn nunerowh
mssudndoawrivioslniodum)

317 4.30 nrhvsuansdoya W.5.0. MIVUAIMIVN WA, 2522

L]



64

]
=

e iendniu “douuzthlumsldsn” szdsngmiuny dagli 431 fu

U
Eg ]
=

! & o H o ., Y Y A A o
dutaautont “mitusnssntlaeady” Adesmsguilemdu sl
{ o { = 1 & ° o
Tglddennasn dggun 432 dluduasaiion “msthyesnuse”
dldannsondntjugdeyantine l 14 Taendnilugnasda lunde

9 LY 9
goundu'ld

- @& 2

@ Dnver Handbook

| ni

H © lumsivsmiossssun mstaosnit |

Lg ondorosdouusnibonaonmuss |

riou MEANHGBUAENG b
1 O msiwnnde tiomsodluinunr n

’ dodonrivwanndeiins:au se:
|

& dratuinfudniiedn Waositu
{hinona

:
(=] Mn&ﬁuﬁmmoi nns?ut'mau
& msosrvui-Hdousomewu
irdosoudidoidunasnsargouiooms
Tatiadonamaunundolout

a v o b 1)
71U 4.32 mineuaasdeyanisihgesnmisn



65

F
A v

¥
4) Tusuveunsonaeulfifesliilom I¥g1Hdongnmueudindudsil

® i1 MsvusaRUNTEazesrasluNIms

@ Driver Handbook

Ui 4.34 nihveuaawe gy msseuvii 2



66

VA v g
® 19 3 N1TNVEVAUUINDA

[a)

@ Driver Handbook

mis L BEE

wanlos,

~ aoulioyanooustisusAisn

NS uNuUnzIoeu 1a:nesn

517 4.36 wihveuanue sy msaeuMin 4



67

® 17 5 NIIIVATN IUYURIN

@ Driver Handbook

wanloo i

 douluoyonaausaie: s,
HunuiasTununateu razmidsn

® =

@ Driver Handbook

waakoy
douluoyondUsIACTUS:A1s0
NUNLIASAUNUNINEU Ia=N10sn

31 4.38 whveuanaediudy MIdouin 6



68

1 c; s a oA drl.
® Nn7 ﬂ']'i‘U‘lJiﬂTﬂﬂﬂgﬂﬂﬂ”lmﬂi@ﬁﬁﬁwfﬁ'mi

@ Driver Handbook

d wéinloe
uluoyayiaiusoia:is:Aisn
St ~#uounasIununsIceuiaGsn

31U 4.39 wihvouaaetiugy mMsaounii 7

422 MFnugMaNRLazMsINGENA?

= o

& Y, &
TUADUMS IFuTiaTi
1) sumslFauTaedldnaniy “‘quanifuaymswsouda” wilsnguiiae

1Yy A95107 4.40

» 2

3U7 4.40 viihesuaALNYNUAITALAZNSHSENAT



69

o

b3
2) 1wy “QuaNUALAzMIWTINAD” fiffem i A l9dendall

]

d’l = 1 =) sSa o Y Lo

e eaanyy “puavadnianilumsiowedeuluduy” szilsing
Y o A

nieYy A3l 4.41

Q

Tudusoinsenusud daouludud
daniiong 16 U il
Tuduiisneud gaovludud
dosiiong 18 U Buly
Tudugdmsnumem muon
\ ¢ Todomsmuood
| amsuu,umsum\-.lu mdomsinlu
| dud) IRBodorhrtiAnsuNsuUdIN
unidiosuuSnu
@ dumsiunainitien
@ Qumsswnod o
@ dumsmucoiinden
@ Intodms
@ yruan Y

-

LT T . L

v
=

3U7 4.41 v wenaasguauliadnLans lumseswedeuludud

e iandaniju “wnaslumstuvodeuludud » sxusinguiivewy asgll

L1

1 4.42

- @ O

ﬂ Driver Handbook

Iem— .

e d

-

vasus:ooudions) wsoviu
nsciluionsussnou IRTd0nsihswms
HSoHanA LAY 7 AlSANU wSouEI
Tususomwng Gongliu 1 1dou
Fuunnseuiiu
voluiuiuuauénmsa ludoiligUrive

+ yoludubmwusssum Tagure 1 (o |
Hwou 2 Tu Dowliiu 6 idou |

B

Ed

314 4.42 mihveuanaenaislumstuveaouludud



A a1 ) o 9/ o =
dienaniju « Yuneulumsaevludud » szalsinguiisomy Atz 4.43

W

-~ @& 1

@ Drniver Handbook

- EC]E]

1=

msvosouluduilis:esom 2 ufnms

=X i3 * X
fosidunouriunua Gy

Sutinsiaouluiivi 1aAnsumsaudiniun
| Tnddnuriu
| 8 tionmshicgauundudorining
nodousuSSIMWMI$VME GIu

@ n 4 Toulisungoirmn
w @ ufin Toemsnotjuikou

| 1 2 1 Togénmminsatu v 'l

© «wn @

‘-‘; kY 3’, v
3N 4.43 vihnouaasvuneulumsaeuluduy

a

d’[ a (] 1 a ci 9/ 1:[
wendnily « Mineoluvid » sxisinguihvemy Aegln 4.44

& 1

@ Driver Handboc

nHsulnsiluduiituoog msdoludui
Tulnou doxhimsousulssinu 2 1
ol iseuonasTiwsou idolduso
dolududdurnninn Toermnluduina
mstooehiiiu 10 Thilousy nosou
aussomu icdoudioBoulng minfuiul
momstiomedu 3 U adnaoviuivi
ThuraHua

=8

-

ai 9 ' @ A
3UN 4.44 milneuaasmsaoegludud



71

4.2.3 MIBNUUUNATY
g £ o w cf
VUADUMT I FNUTAIL
2 Y a £ ! =)
1 Gulavgdlinaniu uuumeder” Fuuyuuunagouulamulszinnvogie
o A @ [N a 4 = )
wisnaeaUszian Moy dyanyoluazing oImueesIvg ngnanINITIUsH
3y o Y A A yg ¥ a oM
douuzilunisldsa wasuvunaaeusiunnises iilod ldnanidaon
é £ 1 o £y " [ 1:{
uuunadeuya laganils azdrgmsiuuunadenluniivens 1 asgUa

4.45

B

@ Driver Handbook

e BEE
®

mOenu

= IaInSaIHLUIEASIAS “ # Mudusonuideslunusie

ANNaMmMsIusn

# Madusomidesiumiumn

|

Jonu=tnfumsidsn
# TRidusonuidealuduth

#* Thsoun




72

3 o a 1 ° a o
o djldneumaAasziinmuansi gldneumauia Sifldnoudiam

a

QNILUMNLARAI N AIFUNY

@ Driver Handbook @ Driver Handbook

BEE
899 gnrﬁmu:ﬂ: Il
Ln'aﬁffmaaﬂ': e

4.2.4 M3lFOUNY (Game For Driver)

4 = 1 1 9 o I~ % o 4 %
ol laaundnntu wwny dl¥nuszgasasuiluaudusosuduagiiedy

U

[

Fou wwudygnuthevsesaums Wdldauwhnsdendelfidligndes mnaeuia

g g

Y J

LT - | Y ;ﬁ' T 1 é 1 1 = a
NHISVUNUN LASHINADUYN ﬁﬂ‘umamuwwma“lﬂmmauma Gmclmmazmu%mmiw

E
@

YY1 oA a wa 1 1 g X 2 A 1 a =
naﬂumﬂwamumanﬂgm URAZIDUAAEAIHITIIIVNE YUADUNITITUIAUNUUAIU



73

1) adnuaunuezdigminendnnisiauny (Game For Driver) Aagalii 4.47

&< Game For Driver

2) aanify “Toau Whgniuaaddmsanldgladle dagi 4.48

U

31N 4.48 vihouaasd i msawny



74

3) aaniu “Guauny” spdhgruiimsiauny Az 4.49

v= Game For Driver

51N 4.49 wihaouaaInIsIEUINY

Y Y a A 1w a o = = <
® mvﬂmmmwwmmuLlwuma“lunmmmwuﬂ VCUNNUDUINTUY

L]

T T ¥ @ W i ) o a o
Llﬁﬂﬁiﬂlﬁu?’]ﬂw%ggﬂﬂ315]5’1]“]_|‘lJTIJ ﬂ\‘lg‘]_]ﬁ 4,50 LLﬂ:ﬂTFﬂ“ﬂﬂﬂUNﬂﬂgﬁﬂﬂ

1 ¥
TU5uaunuIntnnnss

Q"- < Game For Driver

! £ ° =
31 4.50 mihseuanInsaeuiaWAANI 0

AN UATDINITAULAY



79

]
=

v ¥ = A & ¥vd =) A wa
® mvﬂﬂmumaugﬂ %umwuamwuuﬁﬂﬂmwmmwwmﬂgmmuﬂg

P Y

< 1 @ 1 o =
15195 Ngndeuiiusdia’ls endaedie Asgii 4.51

o & a T 1
o fifldnunsugnuuannde wriinmueilmsuuaasliiunglanuay

a

:u

Y =
INUBUSLAD ﬂﬁg“lhﬂ 4.52

¥*=: Game For Driver

ACUYUIAD]
iamgy

\

31N 4.52 wihveuaasmsaoummugnnndovesnsiauny



T W
= o !

4.2.5 MSIFNUAUMINANITNYUE

Yog van v A

76

) A% ' A o Aa ) y Yy 1
GlTJﬂ'I'iﬂu?T'WlﬂiﬂﬁiJ‘UHﬁﬂ LLi‘)WWﬁm”]ﬁuuuiﬁN ﬁb'ﬂ’lum'ﬂﬂﬂuﬂ'ﬂﬂ 2 uyy Ilﬂl.kﬂ

@
v
=

auTagnanIndnug 19 tazduTae Google Map Aag1li 4.53

dulon

fifeii IndAuaa

Google Map

g :

31N 4.53 mheouaauuymsAumnIns U

s

£ = -:; 9 = s - d’. Y A
D aumlagAnanlndnuan  uenwdmduazuaasgannanlndines
- :

a Driver Handbook
/

| \
1 Prachathipat Lam Luk
/ ! Ka District
Si Kan

Sai Mai Khiong Sip Song

Khen | ,
K ¥ / Nong Chok [C31)
Wchak

‘®

/ VBizngKnpil' fl_'a
@ PrawetLal Krabang

BaligNa. 0ok Mi

Min Buri

PHil istrict
Pak Nam ™ g il

Bang Bo Disthet.__

+ !

3118

@
L=

Thailand

[

Ui 4.54 mhoudamsdum laefinan lndnugm



77

v ]
2) Aun1lag Google Map F5HBaUHUAIN Google Map Ao ldarmnsafu

oY W

MmAumanunndesns1a asgilh 4.55

-~ @ 0
Q, nsupuAed x

nron

1000 vim

alnnusudoei. @
4. 1T, 28um

51N 4.55 nihveuanansaun 1ag Google Map

43 MIFNUIDUNYDUY

Y

YY) QUINTD, 1ot P PR
wen N3 iilemdsdoyaiuansnounii uownamsuidiidiuge Iiiana

azaanlumsldauliundlaonaae

4.3.1 UoViu Home (dnuasy3Uiim)

¥
Tudmiimaglévhmsadnilu sevi il dannsoadudignihmanmyvouion-

@ a

a o 1 ] w o
wandui 18 Juiinandddinugnmhaewy degi 4.56

Y



517 4.56 unuARTN Home

a4

4.3.2 uavifunsvgy

1 3 3 o a1 g{y [~} @ ! a o ¥
Tudrutimndldhmsadniuil fldawnsamumsiguyhiilumenwdnguil

]
=

FEuIn@entiIvoNaeIms ba aasUh 4.57

U

- v 4
@ Drniver Handbook

AsUniuy

* filawm3unaay
+ IpSunADUNA B
2plttipt]

AgAEAIATSIUS

Arydnenlindoomnuasos

wse Uy
douuzirluarslasn

* n3unADUUAUA

vinid 1

31 4.57 unpuanatjuensiiey

78



433 ueviunsAumdydnuainnes

¥
Tuguiimnglavimsaanily vz

QU

3 o o o o a o/ {
Aum TaegldezAvafiunmidunid T luuouidu venndmduszuaasdoyandlafum

WA A9 4.58

ﬁ Driver Handboc

k

79

i lFaansarihmsdumitheiidlddens

@ Driver Handbook

Search

&
©
&

3UM 4.58 uouuamatjunisAundey

Y A Y o A do 9
e panisfunuliodlshmsiuimdumihesies

® o

a Dniver Handbook

Search

nTavthe
ATIIMING MWW
Taslmuthotiiuse
MNRINOEUAITUAE
husaSaauthumo
Awseliaseto

nwlasthe
ATTUMINY oM
TAvlvathoidiusa
WRIHDANRITURY
dusnBanutheaay
Anussiage e

A

ATIVING TOW
Tavltmentiiiusn
TRINBANAITURE
dusafaAuthuain
Aselingea

uladafluamdemeo
ATIANE MYV
Tav¥aflupuihmedhe
Wifuso M RowoRuAIS

ﬂ‘}elilﬁl‘i’l‘d‘i

ﬂﬁ 4.59 M9UAAINAMIAUMITURNY I 25105

3]



80

43.4 uppilumsasmmsmenlueysnduiivulfiu

3 v
TudauiimngldhmsadniuglUfiu ezdrguienyidousoorgludui

QU

@ Driver Handbook

neumLsnfmsiadou
niodoowgfuuBuoinn

" 7 T L ‘:1' aa
31 4.60 unvrjunansnsasa Mo lueyaaduIuul iy

: o i @ A
o miwelfiu Fudldmunsommsdsmnsifeudogluduy 14
4.61

fla ey 2074 "

wnrilifiiuuusamnanADE A0
3 8 a9

§ 4 ¥ 1 v a
317 4.61 nlweuanlfinmonsasmnsdeusesigludud

a



43.5 woviuperiusenwamiy

U ldi.‘, ~ ‘i’ s = s o d‘
LLﬂ‘]J‘lJiJ‘H CUTAITWALIDUANYINUVLDWNALAY @Ng‘lj‘ﬂ 4.62

~

. d .;- rell - Tt
g Driver Handbook @ Driver Handbook

= ' a2 o a o
glh'l 4.62 LLﬂ‘]J‘]JiJLLﬁﬂﬂlﬂﬂ’JﬂULL’E’JWWE’Im‘HH

d = T = = 1 v a
® ienanify Send feedback {lFauamisaaennuAARUAILA ArNno

4.63

==

a o a as 1 a 1 o ) @
INTUUONNANTU NNFBINNAINAINGIAZHIAIN 1A Aegl

U

Send email with

m

314 4.63 milvouansreInemsdsnAaR LU,

81



UNN 5

9/
ﬁgﬂwmmzmmaummz

5.1 agiwa
1 '
gonwAAFUINen1Ttassudlveaeu luduativiiau ldegalidszansninoy

— ¢ P { 2 ydo o 1
igu‘].lllﬁﬂﬁﬂ'lﬂiauﬂiﬂﬁﬂ IDIVU 4.1.2 lﬁﬂﬂ'lﬂ\iﬁﬂﬂﬂﬁﬂﬂﬂQuﬂq'lugﬁﬂ-llﬂuﬂﬂﬂ'ﬁﬁﬂﬂ

A g

1 4
Tudva dhlddedldldmsnyulemgilawmIsuaovudlnziiTemalumsaeuniugs

U

o

° a o o a_ o 4 o2 & {0
I&dmahuenndmduiininaassdadauueiuba Sellvinanihooudasnafiaeius
o a o 1 ° 1 = [
TnsAwiausn Wy wanisneasanunansaimauld  uavianthevewennind
o 1w o o a o ]
danavnamidumsiaaswauuanin vy msiinulagsimvesewnandu duisam
w ol sfg 9/ lo’:d’g T 9Yq ¥ 1 o sia’: 9 a Y ~
agszaann laaa 13 uansdiduegivdldauhesihnanudiul g anndeudiels
Y o w
5.2 YednA
1 { 1 -] = a
D wingldaudesmsdlFludiuvesmsdumaniuiinsuvuds Sududeudausms
" 1A ¢ d a ° 1A = 9/ Y
MIyeuRedUmMBIIALAZUTMITEYA LI JeensalFaumsdunngy

yuaeld

s o

2) mnhwenwwdndu lAadsasuuuiuidagudu vuraveanii Layout iffuvuiad
o w o o o o 14 o o o A
i 13 iy InsAnsiiedoaurinTvu dalilimsWaunldiauuuginselau
1a

5.3 YolauBIUL
0 g0d o y
) hldmwsaldauuuunubanseginsoilsziandula
= Y A ' ! A A Y A d? 3 ¥ a o
2) Tinuldideniauannndi 1y iamuamvouny Iduingstiu s lduennandu

= ' L ¢
Hanuiiaulegaau

5.4 Useleminlasy
) Al
2)

A

3o 9 = @ v J
QWthﬂ'i‘UﬂTIiJEGlUH"I'iLﬂ’iﬂﬂﬁ'ﬂﬂlﬂﬁ'ﬂﬂiﬂﬂuﬂ]ﬂﬁ“ﬂﬂﬁm1ﬂﬂu

e e
2

) 9/ s 4
Hanuazanaglumsinnud lauazinsvuda oveaeaulueyne
VY

2
unvuy

e Re &
e G
b Re
=
=

9 =] ' o A g
3) AlFaudTemadourilueyanaduainniy



4)
5)
6)

99 3/ =} ' o A 3
AlanuiiTemeasuriulusyyiaduinniu

vq 3/ 3 o ' = Yo o ' v A T
Aleauazaanlumsdumdwmiansusudsiiog Inanudumiilgiunauey
91

o

- I §
THmuazdldsaldoun Sanunsziededulumsveneulueygaduiunniu

83



84

1NE1591904

=1 =

[1] nsumsvudamaun.w.1.1). gilewIsugeuitevesulusygaduse uas lueyaaii

Vv Y 1 o

Aulszirsn (@iusn). nqamwa : Fafudusia Tsaiuidsnws lne (uaw. Auileslng)

[2] ansn AunesJumdy Tanzaed. 2554. it lnselasenuaoufiaunes szuuudufount
AASaTulA . RuWnsed 1 vouudu : ualn)

[3] Anonymous.2555. Eclipse filoog 15 . Fuduiite 13 NINGIAY, 2556, 91N
http://www.mindphp.conﬂ@:ﬁﬂ/%—ﬁ‘EJEJ315/2240-ec1ipse-ﬁﬂﬂ$\15.html

[4] Anonymous.2555. JAVA fineg'ls . dufhuiile 13 nangiaw, 2556, 11n
http://www.mindphp.com/ﬁ]: ii0/73-fv0z15/2185-Java-foag 15.hml

[5] ansn funes Sumay Tanzaed, 2554, ilaselasanunouiumes ssuvuiafousy
FAsa TR AuWnsed 1 vouudu : (nn)

[6] W1eWIAnT YuN1% .(3.1).4)). M5180u program 1793q). Fuduile 14 NINYIAY, 2556,
970 http://java.pongkorn.net/chS 1.htm

[7] Anonymous .(.1).1)). Inssad1eveaionats XML dudutile 14 nangiay, 2556, 91
http://learnxml.site90.com/structure1.html

[8] Atom , 2556.113U@AASAIN GIF Animation UUUENNARTU . FUAUID 14 nINYIA, 2556,

910 http://www.akexorcist.com/2013/07/android-code-gif-animation.html



.‘- B
bt e et °y

ll.lllllllllllll_-

- ~ Yo o ] A = 2 ' Y o ) ¢y v
wnansiiiluenasnaau Rdwmsums ldaumemsanyunniu ldeyanalii 11l Temisumsm

' ~ ¥ L a4 ¥ 9 agyve & Y Y a R g ¥y A o v
VbJ’nﬂ‘imGlWWNﬁu @ﬂﬂﬂﬁ1ﬂﬂ1ﬂﬂﬂl£ﬂﬁﬂlu@ﬂ’l Llagﬁa\‘lf]’]\‘]’f]\iﬂ\?lﬁ]’lell’f]\uﬂﬂﬁ’lﬁnﬂﬂi\‘]ﬂﬂﬂ'ﬁu'lhlﬂﬁl"]f



MANUHIN 1.

M3AAAY Eclipse 1ta2 Android SDK



87

M3AAAI Eclipse 1 AndroidSDK

.1 35M35 Download'

1) Download (ta¥ Install Eclipse Editor Tadnldh http://www.eclipse.org/downloads

[ www.eclipse.org/downloads/
Vish owner Eclipse Shes

. Embedded development  Hah =
GRLEL T Criedisd doloprent . o »m§d A= @
:

Home Downloads Users Members Committers Resources Projects About Us

AIAEEI'ipse Downloads

Packages Developer Builds o Foliow @ectipserdn  [TITNER 57 °
Eclipse Kepler (4.3.2) SR2 Packages tor [[TFET SR |
Eclipse Standard 4.3.2 2008 Windows 32 8 ( ; ' sprindg
Cownlcaded 1,100,780 Times Other Downioads Windows 64 Bit wiPreotal

The Eclipse Platform. and all the tocls needed o develop and debug it: Java and Flug-
in Development Tooling, Git and CVS..,
FREE ECLIPSE PLUGIN

Package Solutions OR SPRING

Eclipse IDE for Java EE Developers, 250 wa

@ Dowrlcaded 523,726 Times
Tools for Java developers creating Java EE and Web applications, including a Java IDE.

tools for Java EE, JPA, JSF, Mylyn... Related Links
u Compare & Combine Packages
Eclipse IDE for Java Developers, 153 e Windows 32 Bit u Eclipse Indigo (3.7)
Lji Downkaded 256,168 Tmes nscaa R ARg » Echipse Juno (4.2)
%J  The essantial tocls for any_llv.l dmlnhplr. including a Java IDE, a CVS client. Git client. » Install Guide
XML Editer. Mylyn, Maven integration...
= Documentation
PRI} Actuate BIRT iHub Evaluation Package PR i 2 Uplating iipes
B Schedule, distribute & BIRT dashboards, ind k" .
secure output - plus analytics and mere. o =

/ d Yo w o ; i
3 n.1 mihud laddmiuaani Tnan Eclipse Editor

2) Twan Eclipse IDE for Java Developers Iagidonszuuilfiiansvesnouiiunesnuios

¥

A v A VY . S b o & A Y ¥
NANUVNUU (32 1159 64 bit) ‘U1ﬂuuﬂ7|1ﬂ13ﬂﬂﬂﬁﬁﬁﬂulﬂiﬂqclﬂﬁﬂﬂiﬂlﬂ

Eclipse IDE for Java Developers, 153 1B Windows 32 Bit
- Downloaded 255,165 Times Windows 64 Bit

g The essential tools for any Java developer, including a Java IDE, a CVS client, Git client,
XML Editor, Mylyn, Maven integration...

gﬂﬁ 0.2 daundesnrniIvnan Eclipse IDE for Java Developers

¥

msAaRedmsusTUU 1AM Windows Tihmsuan a1l cv dauszuunlfiidnig
Mac tan 1Wd 11147 1an 14

Y a 4 =
'Msaeng Eclipse TMTVIOU Java (Install Eclipse IDE for Java). Fuduiie 21 NWHAINIYU, 2556, 911

http://wadkung. wordpress.com/2012/02/02/how-to-install-android-sdk/
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http://developer.android.com/sdk/index.html
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) developer.android.com sdk/indes atm!

" Developers Design Distribute
Training API Guides Reference Google Services
Developer Tools Get the Android SDK
N
Dovnioad
The Android SDK provides you the API libranes and
Seudnumlhewl developer tools necessary to build. test. and debug
Bundle apps for Android
Setting Up an "
Existing IDE It you're a new Android developer, we recommend you
download the ADT Bundle to quickly start developing
Android Studio 2pps. It includes the essential Android SDK
Exploring the SDK components and a version of the Eclipse IDE with
built-in ADT (Android Developer Tools) to streamline
Dovimload the NDK your Android app development
Workflow Vitha single download, the ADT Bundie includes
everything you need to begin developing apps
Support Library
* Eclipse + ADT plugin
Toolatielp + Android SDK Tools
Revisions * Android Platform-tools
¢ Thelatest Android platform
ADK

+ Thelatest Android system image for the emulator
Android Studio Early Access Preview

Samples

Download t

ADT Bundie for

51 0.3 whin laddmTuarni Tnan Android SDK

" a wa = o Y a o o [
4) ludauves szuvlfianisiarmisominuldluneuiaumes  (Platform)ydniy

a wa a '3 o A d % { { 2
szuulfianmsiuled IdTnaadaidlu Recommended aeg1lii na v¢1@ lWainiiu

) 0 < § 1 o @ a wa
exe MnuuldhmsadldlulaGanesndtldnedmiussuul§innisMac

1 y H
iiavhas Inanee 1d zip File amiviiihmsuan Ind 130 lan 14

Get the Android SDK

The Android SDK provides you the API libraries and
developer 1ools necessary to build, 1est, and debug
apps for Android.

Download the SDK for Mac

Other platforms | System requirements

Windows android-sdk_r20.0.3-windows.zip 90379469
bytes

installer_r20.0.3-windows.exe 70495456
(Recommended) bytes

Mac0S X android-sdk_r20.0.3-macosx.zip 58218455
(intel) bytes

Linux (1386) android-sdk_r20.0.3-linux.1gz 82616305
bytes

¢d895¢c7920117f02507eb3c3B68a c5e

¢f23b95d0c9cd57fac3c3be253171af4

07dc8Bba2c0817ef178a665d002831bf

0d53¢2c31d6b5d0cf7385bccd0b06c27

51/ 0.4 A1 0i Tvan Android SDK
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1) Install ADT Plug-in TagyhnisitlaTusunsu Eclipse duanez ldwiae dagilii n.e

511 0.5 T1/sun3w Eclipse

B Java - Ecipse SDK =@ 0
File Edt Navigate Sesrch Project Run Window Hep

|

|

Overview Tutorials |

l (-) Get an overview of the features Ga through tuterials |
|
l

©4) Samples " What's New
»  Try out the samples V Find out what is new

517 n.6 Tilsunsw Eclipse



2) Ty Help iion Install New Software 92 ldniivodsgali n.7

@ Install

@
2

Available Software
Select a site or enter the location of a site.

L]

1@ There s no site selected.

( Seh;:tAI ][Deselec:Aﬂ]

%

Workwith: type orselectasite - o .

Find more software by working with the "Available Software Sites" preferences.
!(ygeﬁlter(ext' R i .
! Name V:Irsion

Details
Show only the latest versions of available software [T Hide items that are already installed
[] Group items by category What is already installed?

[T] Show only software applicable to target environment
[¥] Contact all update sites during install to find required software

@ < Back Net> || Fmish [ Concel |

' s Y d'
31 0.7 M3AAAY Eclipse 1102 AndroidSDK uaowf 2

¥
1

a A 13 ' @
3) Aaniu Add szlintheetumnlilandsil

® 11993 Name 1% 1d%0 9213]y android W30 ADT Plugin

90

® Ju%049 Location 19 1dAad https://dl-ssl.google.com/android/eclipse/ 21NUUNA OK

= Add Repository

B

Location: https://dl-ssl.google.com/android/eclipse/ Archive...

® l oK ] I Cancel

T P 9 H
310 n.8 M3AAAY Eclipse 11A% AndroidSDK TunuU# 3
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A4 o d = v X o A Yy a A
4) Wemsau lvaaaTud) wwududon Developer Tools T¥indniaen Developer

¥
Tools MNUUNA Next

S Install

Available Software
Check the items that you wish to install.

i type filter text

| Name

| 000 Developer Tools

[ & Android DDMS
4§ Android Development Tools
% Androiel Hierarchy Viewer
4> Android Traceview

[ ]
DE
Workwith:  android - https://di-ssl.google.com/android/eclipse/ ' - =

Find more software by working with the "Available Software Sites" preferences.

Version

16.0.1.¥201112150204-238534
16.01.v201112150204-238534
16.0.1.v201117150204-238534
16.0.1.v201112150204-238534

[ SelectAll | [ DeselectAll | 4 items selected

Details

[#] Show only the latest versions of available software
Group items by category

[] Hide items that are already installed
What is already installed?

[C] Show only software applicable to target environment
Contact all update sites during install to find required software

@

<

8 v Y .ﬁ‘.
511 0.9 M3AAAY Eclipse 118¢ Android SDK Yuaoui 4
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Tsunsuazuanssoazdean1sana U Developer Tools

& Install

Install Details
Review the items to be installed,

| Name

| 4 Android DDMS

| @) Android Development Tools
! 4 Android Hierarchy Viewer

| @ Android Traceview

Version

16.0.1.v2011121502...
16.0.1.v2011121502..,
16.0.1.v2011121502..,
16.0.1,v2011121502...

Id |
com.android.ide.eclipse.ddms.feature.gro,
com.android.ide.eclipse.adt feature.group|
com.android.ide.eclipse.hierarchyviewer.f.
com.android.ide.eclipse.traceview.feature.

[

Size: Unknown d 6
Details

<Back || Net>

¥ ¥ ¥ dl
311 1.10 N15@AAY Eclipse 1Az Android SDK T1aUf 5
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6) 1890 I accept the terms. ... MNUUNA Finish

93

Apache License
Note: jcommon-1.0.12 jar is under the BSD license rather than the Al
Note: lomi2-2.3.0,jar is under the BSD license rather than the EPL. Y¢

Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for
use, reproduction,

and distribution as defined by Sections 1 through 9
of this document.

"Licensor” shall mean the copyright owner or entity
authorized by
the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting
entity and all

other entities that control, are controlled by, or are
under common

control with that entity. For the purposes of this
definition,

"control" means (i) the power, direct or indirect, to
cause the

@ Taccept the terms of the license agreements

£

(7 Ido not accept the terms of the license agreements

-

2 Install i L | B o
Review Licenses | |
Licenses must be reviewed and accepted before the software can be installed. 3:
J Licenses:

Soseo

VIV 7 50 o™ (e | e

3

1

a
n

¥ 9 T
.11 N15AAAS Eclipse 1182 Android SDK UUABUT 6
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9 YN A [V Y A A 5 o iy o g =t
7) Glﬁm“ﬁﬂuﬂulﬂﬂ')ﬂﬂﬂlﬂﬂﬂﬁﬁ 11’Tmﬂﬂ°ﬂ I accept MMNUUNA Finish HAIINAUISUNIT

o o
THand2 ADT Plug-in 19131 15091 Tvamade

[ @ Installing Software B =

@ Installing Software

Fetching org.eclipse.jem.util 21.100.v20110...ases/indigo/201109230900/aggregate/ plugins/

[C] Abways run in background

[RuninBackground] [ Cancel | [ Details>>

[ 1) v :i
gﬂ‘ﬁ .12 N15AARAY Eclipse L Android SDK U4Ha0UN 7

8) o nanmiazdunihaalfng Restart Eclipse nnius Tsunsy Eclipse 329n1/a
s TuiRlddavunln wio &'higndaliihnsaudadatuanlnl

9) wafl¥ ADT Plug-in 1¥iTla cclipse 3501 mnﬁ'u"lﬂﬁsmé Window -> Preferences
{#enTab Android 127 Browse 11/ Tnlainesfianas Android SDK 1073w nsg10
Y99 Windows32bit A0 C:\Program Files\Android\android-sdk @91 Windows 64 bit fiD

C:\Program Files (x86)\Android\android-sdk 9101 NA Apply uAna OK

r 3
@ Preferences | B, 3 J

[t — | i

juipetitegies || Android & e 3
General .
Android iadNencyy S ] )
Ant SDK Location:  C:\Program Files (86]\Android\android-sdk
Help Note: The list of SDK Targets below is only reloaded once you hit ‘Apply’ or 'OK',
Install/Update
Java Target Name Vendor Platform  APL..
Maven Android 233 Android Open Source Project 233 10
Mylyn Android 403 Android Open Source Project  40.3 15
Run/Debug
Team
Usage Data Collector
Validation
WindowBuilder

XML

[Restore Defauits| [ apply |

® [ 0K ][ Cancel l

1 ¥ ¥ H
g‘i.lﬁ 1.13 N139AAY Eclipse 110y Android SDK TUADUTN 8
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10) M3 Adding Platfroms and Other Componentsiﬂﬂﬂaﬂulﬂﬁmh! Window > Android

SDK Manager (u Eclipse for Mac %E]grlu Window)

M-m-

] e D] w®

= J -

a8

‘FieEdilRImVSouuRefndoerigneSur:hijectthodep

o %S HelloAndroid
b 1 test
b 52 testapp

y ¥ ¥ ‘='
314 n.14 M3AAAY Eclipse 1402 Android SDK Tuaaui 9

]C‘lg‘}gd ¥ New Window % o 5 v
New Editor
A mainxml [E Open Perspective java [@ te
import java Shuw.\flew
public clas Customize Perspective...
{ Save Perspective As...
= public e n-re ¥
1 Reset Perspective...
Sys Close Perspective
Sca u tem.in);
int Close All Perspectives
for
{ Navigation
_ﬁ _ Android SDK Manager
& AVD Manager orint("*");
print("*");
Preferences
¥
System.out.println();
}
1
3
4
ffa - .. o~ ™ - (= -
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11) szuaaamiiaiesegl daisuiludeadentie Tools auAUAE Android 1103 5UT

v y
ADINITNNUUNA Install packages

{4 Android SDK Manager

= 8 =

N

his

[[] %/ Android 3.2 (AP113)
| | [z Android 3.1 (API12)
| [l Android 3.0 (API11)

Show: Updates/New [J]Installed  [7] Obsolete Select New or Updates
Sort by: @ API level () Repository Deselect All

Packages Teols
SDK Path: C:\Program Files (86)\Android\android-sdk
Packages
APl Rev.
|
\ 16
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i
‘ [71[Z] Documentation for Android§DK 15 1
[7] %" SDK Platform 15 2
1 15 Samples for SDK 15 1
1 [7] & ARM EABIv7a System Ima 15 1
[7] '#ig Google APIs by Google Ing. 15 1
[ ) Sources for Android 15 1

Status
& Installed
& Installed

& Installed
& Installed
B Installed

Installed
z Installed

B Installed

[ns_tallu;csacléages‘.‘

Delete packages...

Done loading packages.
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12) @@a9n Accept LAINA InstallINUUITDAAAIIUITTD Lﬂuﬂums AU

{4 Choose Packages to Install

R

Packages Package Description & License
“ Google APIs by Google Inc, Android API1...

Archive for any OS
Size: 62.7 MiB

") Accept () Reject

[*] Something depends on this package

Package Description
Android + Google APls, AP 10, revision 2
Requires SDK Platform Android AP110

SHAL: cc0711857 c881a7534f90cf8cc09b8fedB5484d

License
This is the Android Software Development Kit License Agreement.
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MINAAI Adobe Photoshop CS6

4.1 M3 Download Adobe Photoshop CS6~
1) 91113 Download Adobe Photoshop CS6 Taoidn 11 Tvaah

http://www.adobe.com/downloads

[) www.adobe.com/downloads.html|

Mate Privacy W My cart Sign in to My Adobe ¥
Adobe Downloads

Producttrisls  Product updates  Other downloads
ioad

e e Adobe Reader

L

Creative Cloud

£ Adobe Flash Hayer

Adot= AIR

need to create anything

Adobe Shockwave Payer

Adobe’ Labs

Select any of the applications below to download a free trial. Or sign up for your free trial of Adobe Labs provides you with the

Creative Cloud to get free access 1o all of these applications, Touch Apps, web storage, and more CparinityRo epglents and
evaluate new and emerging

innovations, technologles, and

Featured free trial downloads products from Adabe. Learn more »
Creative Cloud Photoshop CC A o After Effects CC
All the tools you needto Image editing and SIS Cinematic visual effects and
create, collaborate, and compositing. i motion graphics B3
stay insync Join| Try | Learn mare Jain| Try |Leam more L
Jain| Start for free | Learn Photoshop CC and
g Lightroom 5 for ¥*59.99/mo.

31 w1 wihdu leddmsuaiad Inaa Adobe Photoshop CS6

2) M§3970 Download Photoshop CS6 Funaanald ¢ 30 Tuuudndr ldaIames

1 Qs Qﬁf )
Y94 Photoshop AUANNAIUAN AUIDAAAN Set-up

b ) ' b b N

[
Deployment packages payloads resources Set-up

FEon,

311 4.2M3 Download Adobe Photoshop CS6

* N15AAAY Adube Photoshop CS6. FUAUIIB 21 WOATABY, 2556, 1A http://photoshop-cs6-

basic560.blogspot.com/2014/01/photoshop-cs6-adobe-photoshop-cs6.html



4.2 MSAAAY Adobe Photoshop CS6
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1) 1WhgnszunsEuAudmSUNITAAAS Photoshop CS6

(B8 Adobe Installer (S |

Initializing Installer

! ¥ 4 ﬂi
710 4.3 M3AaAs Adobe Photoshop CS6 LAOUTN 1

2) dindsingmihaesamunindruaisnaniy Try

(B Adobe Photoshop CS6 e =

Welcome

99

R Install
A 1 have a serial number,

r Try

Iwant to try Adobe Photoshop CS6 for a limited time.,

Quit
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3) ﬂaﬂﬂu Accept

-
[E Adobe Photoshop CS6

Adobe Software License Agreement

English (North America) ~

ADOBE

Software License Agreement

PLEASE READ THIS AGREEMENT CAREFULLY, BY COPYING, INSTALLING, OR USING ALL OR ANY PORTION OF THIS
SOFTWARE, YOU (HEREINAFTER "CUSTOMER") ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT,
INCLUDING, WITHOUT LIMITATION, THE PROVISIONS ON LICENSE RESTRICTIONS IN SECTION 4, LIMITED
WARRANTY IN SECTIONS 6 AND 7, LIMITATION OF LIABILITY IN SECTION 8, AND SPECIFIC PROVISIONS AND
EXCEPTIONS IN SECTION 16. CUSTOMER AGREES THAT THIS AGREEMENT IS LIKE ANY WRITTEN NEGOTIATED
AGREEMENT SIGNED BY CUSTOMER. THIS AGREEMENT IS ENFORCEABLE AGAINST CUSTOMER. IF CUSTOMER DOES
NOT AGREE TO THE TERMS OF THIS AGREEMENT, CUSTOMER MAY NOT USE THE SOFTWARE,

Customer may have another written agreement directly with Adobe (e.g., a volume license agreement) that
supplements or supersedes all or portions of this agreement, The Software is LICENSED, NOT SOLD, only in accordance

with the terms of this agreement. Use of some Adobe and some non-Adobe materials and services included in or
accessed through the Software may be subject to additional terms and conditions. Notices about non-Adobe

materials are available at_http://www.adobe.com/go/thirdparty.

H 9 v ‘!l
317 4.5 M3AAAT Adobe Photoshop CS6 UUADUN 3
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4) fany Sign in

[8 Adobe Photoshop C56 [ESREE )

Sign In Required

Please sign in with your Adobe ID to start your trial for Adobe Photoshop CS6.

Terms and conditions for trial software.

We may ask you to provide us with optional information so that we can tailor content for you. You can turn
off this customized content at any time by going to the Privacy Settings located on the trial experience
screen.

For information about data we collect about your use of the product, and how Adobe uses that data,
including how we market to your interests, click here and see the Adobe Online Privacy Policy.

-

H ¢ - 4 "
317 4.6 M35an3 Adobe Photoshop CS6 TUADLT 4

o - Cww. 70 J y o
5) 590 Adobe ID m"lﬁ’mﬂ‘rsﬁuﬂﬁmumau Download File Lﬁ@miﬂﬁﬂu%}@ﬂug?
ﬂaﬂﬂll Sign in
FN Adobe Photoshop €56 [E=N

Sign In

You must sign in with an Adobe ID.
Adobe ID (Email Address)
ninetechno@gmail.com Create an Adobe ID

Password

Your credentials will be stored on this device.

Trouble signing in?

1 F Fd '
gﬂ‘ﬁ 9.7 NIAAAY Adobe Photoshop CS6 UUADUN 5
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(B Adobe Photoshop CS6 [E=SREE )

Options

B Adobe Photoshop €56 19 GB

Click a product name to
customize options
Total Install: 1.9GB

Language: Location: 113.3 GB Available

English (North .. = C:\Program Files\Adobe

' e P> n b
31N 2.8 M38AAT Adobe Photoshop CS6 YUABIA 6

T / I~ o <
7) ’ﬁ]%ﬂ'ﬁ‘lﬂﬂﬂﬁ?ﬂ’]& Installation Complete WudwaFaFeuien

Installation Complete

These applications are ready for use.

To manage this or your other Genuine Adobe software, go to
http://www.adobe.com/go/adobemembership.

My Adobe | Video Tutorials

(' Adobe Photoshop €56 [ESN )
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M3a31971N Animation GIF 228115154 Photoshop’
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¥ ]
3) NUUIINIAN dialog Animation Taglilnfinidoniuy Window > Animation

[Window | Help

Arrange 4
Workspace ’

Actions Alt+F9

] Animation
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¥ Character
Clone Source
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Histogram
I v History
Info
Layer Comps
¥ Layers
Measurement Log
v Navigator
v Options
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Paths
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Tool Presets
¥ Tools

v 1 kittyl jpg

; e
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8) o ldmudesmsudalininisiiudinTaglifimy File > Save for Web & Devices. .
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[File] Edit Image Layer Select Filter Analysis

New... Ctrl+N
Open... Ctrl+Q
Browse.., Alt+Ctrl+0
Open As.., Alt+Shift+Ctrl+ 0
QOpen As Smart Object...

Open Recent »
Device Central...

Close Ctri+W
Close All Alt+Ctrl+W
Close and Go To Bridge... Shift+ Ctrl+W
Save Ctrl+S
Save As... Shift+ Ctrl+5
Check In...

Alt+Shift+ Ctel+ S

Import

Export 4
Automate L4

Scripts L4

File Info... Alt+Shift+Ctrl+I

Page Setup.., Shift+Ctrl+P [»] «
Print... Ctrl+P :
Print One Copy Alt+Shift+Ctrl+P

Exit Ctrl+Q
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